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Linking the Custom CARLI_Reports_20XX.mdb File  
Periodically, CARLI releases a custom CARLI_reports_20XX.mdb (where XX is the year the file was released). 
This file contains the Ex Libris prepackaged reports that are suitable for the I-Share environment, and also 
contains shared SQL and other statistical queries provided by CARLI. 
 
The latest custom file can be downloaded from the CARLI website at  
https://www.carli.illinois.edu/products-services/i-share/execute: look for the “Latest version of custom 
CARLI_Reports_20XX.mdb.” 
 
CARLI strongly recommends that you use the latest CARLI custom file in place of the generic Reports.mdb file 
or the previous custom CARLI_reports.mdb file.  For more information about what is included in the current 
custom file, see  
http://www.carli.illinois.edu/products-services/i-share/reports/secure/CARLI-reports2016-info. 
 
For information on how to “copy” queries from your previous .mdb file into a new .mdb file, see 
http://www.carli.illinois.edu/products-services/i-share/reports/secure/copying-queries 
 
This document presumes that you have already completely installed Oracle 10g and ODBC on your PC 
according to the CARLI specifications. If you have not, please see the Installation instructions at 
http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/newinstall_10g.pdf.  
 
These instructions apply only to running 32-bit versions of Microsoft Access 2002 and later. The Oracle10g 
client may not function with 64-bit access. See “Known Issues for 64-bit Windows and Office” in Appendix B for 
more details on supported software. 
 
Instructions for MS Access 2010 or later 

Linking instructions for MS Access 2007 begin on page 6 
Linking instructions for MS Access 2003 or earlier begin on page 11 
 
Note: Screenshots may depict both Access 2010 and 2013 

 
1. Set Macro Security Level  
 

a. Start MS Access  
 

b. Select the File tab 
 

c. Click Options 
 

d. Select the “Trust Center” in the left-hand pane. Select “Trust Center Settings…” 
 

e. Select “Macro Settings” in left-hand pane. Select the radio button next to “Enable all macros 
(not recommended; potentially dangerous code can run)” Click OK. Click OK again. 

 
f. You must Exit and restart MS Access  
 

2. Decide if you will use the default Reports.mdb file or the CARLI_reports_2016.mdb file (see Before 
You Start section above). 

 
a. Navigate to the file on your PC 
 
b. Highlight the file and either Right-click or use the Edit menu to either make a copy of the file or to 

rename the file: eisreport.mdb 
 
c. Copying and/or Renaming this file will help you to know that this is the file you have linked up to 

https://www.carli.illinois.edu/products-services/i-share/execute
http://www.carli.illinois.edu/products-services/i-share/reports/secure/CARLI-reports2016-info
http://www.carli.illinois.edu/products-services/i-share/reports/secure/copying-queries
http://www.carli.illinois.edu/sites/files/i-share/documentation/secure/newinstall_10g.pdf
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the database, and may help to identify it after future upgrades. 
 
d. The remainder of these instructions will refer to this file as eisreport.mdb 

 
3. Open the eisreport.mdb file in MSAccess  

 
 

4. Prepare the file for linking 
a. Click on “External Data” tab 
 
b. Select “ODBC Database” 
 

 
 

 
c. The “Get External Data‐ODBC Database” screen pops up. Select “Link to the data source by 

creating a linked table.” Click OK. 
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d. The “Select Data Source” screen pops up. Select “Machine Data Source” tab, choose 

“eisreport” and click OK. 
 

 
 
If you receive a security warning that says some content was disabled, choose to “Enable this 

content”. 
If you do not see eisreport listed as a Data Source Name, click Cancel. Verify whether you are using 

a 32-bit or 64-bit version of Access (Go to File, Account, About Access). 
 
e. The “Microsoft ODBC for Oracle Connect” screen pops up.  
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i. For User Name enter <your Oracle username>  
 

ii. For Password enter <your Oracle Password>  
 

iii. For Server enter VGER  
 

iv. Click OK.  
 

 
 

NOTE: It may take a few minutes before the next screen appears.  
 

f. The Link Tables screen will appear.  Click Deselect All.  

 
 
g. The box should briefly refresh and the Deselect All button will pop back up.  Then click OK. 
 

5. Build Database Links  
 

a. Click on the arrow at the end of the Navigation Bar 
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b. Select Forms 

  
 
 

c. Double-click Build database links to Voyager  

 
 

d. The Build links to Voyager box will appear.  Enter the following values: 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ODBC Name eisreport 

Connect String VGER 

DB User ID  
(remove dbread) 

<your Oracle 
Username> 

Password  
(remove existing 
*s) 

<your Oracle 
Password> 

Tablespace*** XXXDB 

Relink checkbox Checked 
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***Where XXX represents your I-Share Voyager three-letter code in uppercase letters.  See Appendix A. 
 

Click Connect.  
 

i. If the connection is successful, the bottom window will list each table as it is 
successfully linked. The ALL_TAB_COLUMNS table will not link. This is not an error.  

 
ii. If you receive "error!" statements followed by "Process stopped too many errors!,” click 

Close and repeat steps 4-5 again, carefully checking the information being entered.  If 
you continue to receive error messages, contact the CARLI Office for assistance. 

 
iii. The linking will take anywhere from a few minutes to several hours, depending on your 

network connection. 
 

d. When the linking is complete (after linking through tables from A to Z), click Close in the “Build 
database links to Voyager” box. 

 

Prepackaged Reports are now successfully linked! 
You may now run queries and reports against the database. 

 
Instructions for MS Access 2007 

If you are using an earlier version of MS Access (2003 or earlier) please see linking 
instructions beginning on page 27 

 
1. Set Macro Security Level  
 

a. Start MS Access  

b. Select the Microsoft Office Button:   
 
c. Click Access Options 
 
d. Select the “Trust Center” in the left-hand pane. Select “Trust Center Settings…” 
 
e. Select “Macro Settings” in left-hand pane. Select the radio button next to “Enable all macros (not 

recommended; potentially dangerous code can run)” Click OK. Click OK again. 
  

f. You must Exit and restart MS Access  
 

2. Decide if you will use the default Reports.mdb file or the CARLI_reports_2016.mdb file (see Before 
You Start section above). 

 
a. Navigate to the file on your PC 
 
b. Highlight the file and either Right-click or use the Edit menu to either make a copy of the file or to 

rename the file: eisreport.mdb 
 
c. Copying and/or Renaming this file will help you to know that this is the file you have linked up to 

the database, and may help to identify it after future upgrades. 
 
d. The remainder of these instructions will refer to this file as eisreport.mdb 

 
3. Open the eisreport.mdb file in MSAccess  
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4. Prepare the file for linking 

a. Click on “External Data” tab 
 
b. Click on the “More” arrow in the “Import” section 
 
c. Select “ODBC Database” 
 

 
 

 
d. The “Get External Data‐ODBC Database” screen pops up. Select “Link to the data source by 

creating a linked table.” Click OK. 
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e. The “Select Data Source” screen pops up. Select “Machine Data Source” tab, choose 

“eisreport” and click OK. 
 

 
 
If you receive a security warning that says some content was disabled, choose to “Enable this 

content”. 
 
f. The “Microsoft ODBC for Oracle Connect” screen pops up.  

 
i. For User Name enter <your Oracle username>  

 
ii. For Password enter <your Oracle Password>  

 
iii. For Server enter VGER  

 
iv. Click OK.  

 

 
 

NOTE: It may take a few minutes before the next screen appears.  
 

g. The Link Tables screen will appear.  Click Deselect All.  
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h. The box should briefly refresh and the Deselect All button will pop back up.  Then click OK. 
 

5. Build Database Links  
 

e. Click on the arrow at the end of the Navigation Bar 

 
f. Select Forms 
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g. Double-click Build database links to Voyager  

 
 

h. The Build links to Voyager box will appear.  Enter the following values: 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
***Where XXX represents your I-Share Voyager three-letter code in uppercase letters.  See Appendix A. 

 
Click Connect.  

 
i. If the connection is successful, the bottom window will list each table as it is 

successfully linked. The ALL_TAB_COLUMNS table will not link. This is not an error.  
 
ii. If you receive "error!" statements followed by "Process stopped too many errors!,” click 

Close and repeat steps 4-5 again, carefully checking the information being entered.  If 
you continue to receive error messages, contact the CARLI Office for assistance. 

 
iii. The linking will take anywhere from a few minutes to several hours, depending on your 

network connection. 
 

d. When the linking is complete (after linking through tables from A to Z), click Close in the “Build 
database links to Voyager” box. 

 

Prepackaged Reports are now successfully linked! 
You may now run queries and reports against the database. 

 

ODBC Name eisreport 

Connect String VGER 

DB User ID  
(remove dbread) 

<your Oracle 
Username> 

Password  
(remove existing 
*s) 

<your Oracle 
Password> 

Tablespace*** XXXdb 

Relink checkbox Checked 
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Instructions for MS Access 2003 or earlier 

 
0. If you are using MS Access 2003 or later, complete this step zero.  Otherwise, proceed to step 1 

below.  
 

a. Start MS Access  
 
b. Select Tools  Macro  Security  Security Level tab 
 
c. Select the Low option  
 
d. Click OK  
 
e. You will receive a message indicating that “Unsafe expressions are blocked…Do you want to 

allow the evaluation of potentially unsafe expressions?”  Click Yes  
 
f. You must Exit and restart MS Access  
 

1. Decide if you will use the default Reports.mdb file or the CARLI_reports_2009.mdb file (see Before You 
Start section above). 

 
a. Navigate to the file on your PC 
 
b. Highlight the file and either Right-click or use the Edit menu to either make a copy of the file or to 

rename the file: eisreport.mdb 
 
c. Copying and/or Renaming this file will help you to know that this is the file you have linked up to 

the database, and may help to identify it after future upgrades. 
 
d. The remainder of these instructions will refer to this file as eisreport.mdb 

 
2. Open the eisreport.mdb file in MSAccess  

 
 

3. Prepare the file for linking 
 

a. Select File  Get External Data  Link Tables  

 
 

 
b. A Link box will appear  
 

i. Click the Files of Type drop down located at the bottom of the screen  
 

ii. Select ODBC Databases, usually located at the bottom of the list:  
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c. The Link screen will be replaced by the Select Data Source screen  
 

i. Select the Machine Data Source tab.  
 

ii. Select the Data Source Name eisreport  

 
iii. Click OK  
 

d. The Select Data Source window will be replaced by a Microsoft ODBC for Oracle Connect 
window.  

 
i. For User Name enter <your Oracle username>  
 
ii. For Password enter <your Oracle Password>  
 
iii. For Server enter VGER  
 
iv. Click OK.  
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NOTE: It may take a few minutes before the next screen appears.  
 

e. The Link Tables screen will appear.  Click Deselect All.  

 
 
f. The box should briefly refresh and the Deselect All button will pop back up.  Then click OK. 
 

4. Build Database Links  
 

a. Under Objects select the Forms option  

 
 

b. Double-click Build database links to Voyager  
 
c. The Build links to Voyager box will appear.  Enter the following values: 

 
ODBC Name eisreport 

Connect String VGER 

DB User ID  
(remove dbread) 

<your Oracle 
Username> 
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***Where XXX represents your I-Share Voyager three-letter code in uppercase letters.  See Appendix A. 
 

Click Connect.  
 

i. If the connection is successful, the bottom window will list each table as it is 
successfully linked. The ALL_TAB_COLUMNS table will not link. This is not an error.  

 
ii. If you receive "error!" statements followed by "Process stopped too many errors!,” click 

Close and repeat steps 4-11 again, carefully checking the information being entered.  If 
you continue to receive error messages, contact the CARLI Office for assistance. 

 
iii. The linking will take anywhere from a few minutes to several hours, depending on your 

network connection. 
 

d. When the linking is complete (after linking through tables from A to Z), click Close in the “Build 
database links to Voyager” box. 

 

Prepackaged Reports are now successfully linked! 
You may now run queries and reports against the database.

Password  
(remove existing 
*s) 

<your Oracle 
Password> 

Tablespace*** XXXdb 

Relink checkbox Checked 
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LIBRARY CODE  LIBRARY CODE 
Adler University ADL  Lincoln Land Community College LLC 
Augustana College AUG  MacMurray College MMC 
Aurora University ARU  McKendree University MCK 
Benedictine University BEN  Meadville Lombard Seminary MLS 
Black Hawk College BHC  Millikin University MIL 
Bradley University BRA  Monmouth College MON 
Carl Sandburg College CSC  Morton College MRT 
Catholic Theological Union CTU  National-Louis University NLU 
Chicago State University CSU  The Newberry Library NBY 
College of DuPage COD  North Central College NCC 
Columbia College COL  North Park University NPU 
Concordia University Chicago CON  Northeastern Illinois University NEI 
Danville Area Community College DAC  Northern Illinois University NIU 
DePaul University DPU  Northern Seminary NBT 
Dominican University DOM  Oakton Community College OAK 
Eastern Illinois University EIU  Olivet Nazarene University ONU 
Elmhurst College ELM  Parkland College PRK 
Eureka College ERK  Principia College PRC 
Governors State University GSU  Quincy University QCY 
Greenville College GRN  Richland Community College RCC 
Harper College WRH  Robert Morris University RMC 
Heartland Community College HRT  Roosevelt University ROU 
Illinois Central College ICC  Rush University RSH 
Illinois College ILC  Saint Francis Medical Ctr College of Nursing SFM 
Illinois Eastern Community Colleges IEC  Saint Xavier University SXU 
Illinois Institute of Technology IIT  Sauk Valley Community College SVC 
Illinois Math & Science Academy IMS  School of the Art Institute Chicago SAI 
Illinois State Library ISL  South Suburban College SSC 
Illinois State University ISU  Southeastern Illinois College SEI 
Illinois Valley Community College IVC  Southern Illinois University Carbondale SIC 
Illinois Wesleyan University IWU  Southern Illinois University Edwardsville SIE 
JKM Library JKM  Southern Illinois University School of Medicine SIM 
John Wood Community College JWC  Southwestern Illinois College SWI 
Joliet Junior College JOL  Trinity Christian College TRN 
Judson University JUD  Trinity International University TIU 
Kankakee Community College KCC  Triton College TRT 
Kishwaukee College KIS  University of Illinois at Chicago UIC 
Knox College KNX  University of Illinois at Springfield UIS 
Lake Forest College LFC  University of Illinois at Urbana-Champaign UIU 
Lewis & Clark Community College LAC  University of Saint Francis USF 
Lewis University LEW  University of St. Mary of the Lake SML 
Lincoln Christian College & Seminary LCC  Western Illinois University WIU 
Lincoln College LNC  Wheaton College WHE 
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Appendix B 
Known Issues for 64-bit Windows and Office 
 
Unable to locate either Microsoft ODBC for Oracle or eisreport DSN on 64-bit Windows 
 

You must use the 32-bit ODBC drivers in order to find the "Microsoft ODBC for Oracle" driver needed 
during configuration of your ODBC connection in Section IV, steps 16-21 of the CARLI I-Share Oracle 
10g/ODBC New Installation Guide. The 32-bit version of the Microsoft ODBC Administrator can usually 
be found at C:\Windows\SysWOW64\odbcad32.exe. 
 
To access the 32-bit drivers perform the following in place of step 16. 
 
16a. Open the Windows file explorer and navigate to the C:\Windows\SysWOW64 folder. Locate the 
odbcad32.exe file. Right-click it and select “Run as Admin”.   
 
Return to step 17 above and continue with the directions as normal. 
 

64-bit versions of Microsoft Office 
 

64-bit Microsoft Office installed on 64-bit Windows 7 will not work with Oracle/ODBC for reporting 
against Voyager. Ex Libris only supports an installation using Oracle 10g clients and 32-bit Microsoft 
Access. 
 
If your institution has the ability to support later versions of the Oracle ODBC clients, then you may be 
able to use 64-bit Access with Voyager. CARLI may not be able to provide troubleshooting on 
installation for this configuration. 
 

Microsoft Office 365 
 

At this writing, neither Ex Libris nor CARLI support the use of Microsoft Office 365 with ODBC or 
Voyager. 
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